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1.  INTRODUCTION

The RCM3209 and RCM3229 RabbitCore® modules are designed

to be the heart of embedded control systems. The RCM3209 fea-

tures an integrated 10/100Base-T Ethernet port and provides for

LAN and Internet-enabled systems to be built as easily as serial-

communication systems.

In addition to the features already mentioned above, the RCM3209 and RCM3229 have 

two clocks (main oscillator and real-time clock), reset circuitry, and the circuitry necessary 

for management of battery backup of the Rabbit 3000’s internal real-time clock and the 

static RAM. Two 34-pin headers bring out the Rabbit 3000 I/O bus lines, parallel ports, 

and serial ports.

The RCM3209 or RCM3229 receives +3.3 V power from the customer-supplied mother-

board on which it is mounted. The RCM3209 and RCM3229 can interface with all kinds 

of CMOS-compatible digital devices through the motherboard.

The Development Kit has what you need to design your own microprocessor-based 

system: a complete Dynamic C software development system and a Prototyping Board 

that allows you to evaluate the RCM3209 or RCM3229, and to prototype circuits that 

interface to the RCM3209 or RCM3229 module.
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1.1  RCM3209/RCM3229 Features

• Small size: 1.85" x 2.73" x 0.86"

(47 mm x 69 mm x 22 mm) 

• Microprocessor: Rabbit 3000 running at 44.2 MHz

• (RCM3209 only) 10/100Base-T auto MDI/MDIX Ethernet port chooses Ethernet inter-

face automatically based on whether a crossover cable or a straight-through cable is 

used in a particular setup

• 52 parallel 5 V tolerant I/O lines: 44 configurable for I/O, 4 fixed inputs, 4 fixed outputs

• Two additional digital inputs, two additional digital outputs

• External reset input

• Alternate I/O bus can be configured for 8 data lines and 6 address lines (shared with 

parallel I/O lines), I/O read/write

• Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers 

• 512K flash memory, 512K program execution SRAM, 256K data SRAM

• Real-time clock

• Watchdog supervisor

• Provision for customer-supplied backup battery via connections on header J2

• 10-bit free-running PWM counter and four width registers

• Two-channel Input Capture can be used to time input signals from various port pins

• Two-channel Quadrature Decoder accepts inputs from external incremental encoder 

modules

• Six CMOS-compatible serial ports: maximum asynchronous baud rate of 5.5 Mbps. Four 

ports are configurable as a clocked serial port (SPI), and two ports are configurable as 

SDLC/HDLC serial ports.

• Supports 1.15 Mbps IrDA transceiver.

The RCM3209 and RCM3229 modules are similar in form, dimensions, and function to 

the RCM3200/RCM3220, and based on the RCM3900 RabbitCore modules which were 

first released in 2008. The RCM3900/RCM3910 and RCM3309/RCM3319 RabbitCore 

modules are similar to the RCM3209/RCM3229, but they offer fixed NAND and/or 

removable media mass-storage memories.The RCM3309 and the RCM3319 offer fixed 

serial flash mass-storage options instead.
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Table 1 summarizes the main features of the RCM3209 and the RCM3229 modules.

The RCM3209 and RCM3229 are programmed over a standard PC USB serial port 

through a programming cable supplied with the Development Kit, and can also be pro-

gramed directly over an Ethernet link using the RabbitLink.

Appendix A provides detailed specifications for the RCM3209/RCM3229.

1.2  Comparing the RCM3209/RCM3229 and RCM3200/RCM3220

This section compares the two lines of RabbitCore modules.

• Temperature Specifications — We can no longer obtain certain components for the 

RCM3200/RCM3220 RabbitCore modules that support the -40°C to +70°C temperature 

range. RCM3200/RCM3220 RabbitCore modules manufactured after May, 2008, are 

specified to operate at 0°C to +70°C. The RCM3209/RCM3229, rated for -40°C to 

+85°C, are offered to customers requiring a larger temperature range after May, 2008.

• Maximum Current — The RCM3200/RCM3220 draws 255 mA vs. the 325 mA 

required by the RCM3209 (with Ethernet) or 190 mA (RCM3229 without Ethernet).

• LEDs — The LNK/ACT LEDs have been combined to one LED on the RCM3209, and 

the RCM3209 has an FDX/COL LED where the ACT LED was on the RCM3200. The 

RCM3229, like the RCM3220, has no LEDs and no Ethernet.

• Ethernet chip. A different Ethernet controller chip is used on the RCM3209. The 

Ethernet chip is able to detect automatically whether a crossover cable or a straight-

through cable is being used in a particular setup, and will configure the signals on the 

Ethernet jack interface. The RCM3229, like the RCM3220, has no Ethernet interface.

• Dynamic C — You may run an application developed for the RCM3200/RCM3220 on 

the RCM3209/RCM3229 after you recompile it using Dynamic C v. 9.60. The new 

Dynamic C release incorporates many of the modules that previously had to be pur-

chased separately.

Table 1.  RCM3209/RCM3229 Features

Feature RCM3209 RCM3229

Microprocessor Rabbit 3000 running at 44.2 MHz

SRAM 512K program (fast SRAM) + 256K data

Flash Memory (program) 512K

RJ-45 Ethernet Connector, 

Filter Capacitors, and LEDs
Yes No

Serial Ports

6 shared high-speed, CMOS-compatible ports:

6 are configurable as asynchronous serial ports;

4 are configurable as clocked serial ports (SPI);

2 are configurable as SDLC/HDLC serial ports;

1 asynchronous serial port is dedicated for programming
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1.3  Advantages of the RCM3209/RCM3229

• Fast time to market using a fully engineered, “ready to run” microprocessor core.

• Competitive pricing when compared with the alternative of purchasing and assembling 

individual components.

• Easy C-language program development and debugging

• Program Download Utility and cloning board options for rapid production loading of 

programs.

• Generous memory size allows large programs with tens of thousands of lines of code, 

and substantial data storage.

• Integrated Ethernet port for network connectivity, royalty-free TCP/IP software.

• Pin-compatible with RCM3309/RCM3319 and RCM3900/RCM3910 to offer fixed 

and/or removable media mass-storage memory options.
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1.4  Development and Evaluation Tools

1.4.1  RCM3200 Development Kit

The RCM3200 Development Kit contains the hardware you need to use your RCM3209 

or RCM3229 module.

• RCM3209 module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., 

and European style plugs).

• USB programming cable with 10-pin header.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Getting Started instructions.

• Accessory parts for use on the Prototyping Board.

• Screwdriver and Cat. 5 Ethernet cables.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Figure 1.  RCM3200 Development Kit

Rabbit, Dynamic C, and Digi are registered trademarks of Digi International Inc.

RabbitCore RCM3309/RCM3319

The RCM3309/RCM3319 RabbitCore modules feature built-in Ethernet, and onboard mass storage (serial 

flash). These Getting Started instructions included with the Development Kit will help you get your 

RCM3309 up and running so that you can run the sample programs to explore its capabilities and develop 

your own applications.

Development Kit Contents

The RCM3309/RCM3319 Development Kit contains the following items

• RCM3309 module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 

European style plugs).

• USB programming cable with 10-pin header.

• Dynamic C® CD-ROM — with complete product documentation on disk.

• A bag of accessory parts for use on the Prototyping Board.

• Screwdriver and Cat. 5 Ethernet cables.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Visit our online Rabbit store at www.rabbit.com/store/ for 

the latest information on peripherals and accessories that 

are available for the RCM3309/RCM3319 RabbitCore 

modules.

Installing Dynamic C®

Insert the CD from the Development Kit in 

your PC’s CD-ROM drive. If the installation 

does not auto-start, run the setup.exe pro-

gram in the root directory of the Dynamic C 

CD. Install any optional Dynamic C modules 

or packs after you install Dynamic C.
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1.4.2  Software

The RCM3209 and the RCM3229 are programmed using version 9.60 of Rabbit’s 

Dynamic C. A compatible version is included on the Development Kit CD-ROM. This 

version of Dynamic C includes the popular µC/OS-II real-time operating system, point-to-

point protocol (PPP), FAT file system, RabbitWeb, and other select libraries.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our Web site at 

www.rabbit.com for further information and complete documentation, or contact your 

Rabbit sales representative or authorized distributor.

1.4.3  Connectivity Interface Kits

Rabbit has available a Connector Adapter Board to allow you to use the the RCM3209/

RCM3229 with header sockets that have a 0.1" pitch.

• Connector Adapter Board (Part No. 151-0114)—allows you to plug the RCM3209/

RCM3229 whose headers have a 2 mm pitch into header sockets with a 0.1" pitch.

Visit our Web site at www.rabbit.com or contact your Rabbit sales representative or autho-

rized distributor for further information.

1.4.4  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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2.  HARDWARE SETUP

This chapter describes how to set up and connect the RCM3209 and

the Prototyping Board included in the RCM3200 Development Kit.

NOTE: This chapter (and this manual) assume that you have a Development Kit. If you 

purchased an RCM3200 series RabbitCore module by itself, you will have to adapt the 

information in this chapter and elsewhere to your test and development setup.

2.1  Install Dynamic C

To develop and debug programs for an RCM3200 series RabbitCore module (and for all 

other Rabbit hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C, do so now by inserting the Dynamic C CD from 

the Development Kit in your PC’s CD-ROM drive. If autorun is enabled, the CD installa-

tion will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start | Run menu or Windows Disk Explorer to launch setup.exe from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used. The default selec-

tion is COM1. Select any available USB port for Dynamic C’s use.This selection can be 

changed later within Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may lead to a message such 

as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased the optional Dynamic C Rabbit Embedded Security Pack, install it 

after installing Dynamic C. You must install the Rabbit Embedded Security Pack in the 

same directory where Dynamic C was installed.
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2.2  Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the 

sample programs:

1. Attach the RCM3200 series RabbitCore module to the Prototyping Board.

2. Connect the programming cable between the RCM3200 series RabbitCore module and 

the workstation PC.

3. Connect the power supply to the Prototyping Board.
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2.2.1  Step 1 — Attach Module to Prototyping Board

Turn the RCM3209 module so that the Ethernet connector end of the module extends off 

the Prototyping Board, as shown in Figure 2 below. Align the pins from headers J61 and 

J62 on the bottom side of the module into header sockets RCM2JA and RCM2JB on the 

Prototyping Board. The installation of the RCM3229, which does not have an Ethernet 

connector, is similar.

Figure 2.  Install the RCM3209 Module on the Prototyping Board

Although you can install a single module into either the MASTER or the SLAVE position 

on the Prototyping Board, all the Prototyping Board features (switches, LEDs, serial port 

drivers, etc.) are connected to the MASTER position — install a single module in the 

MASTER position.

NOTE: It is important that you line up the pins on headers J61 and J62 of the RCM3209/

RCM3229 exactly with the corresponding pins of header sockets RCM2JA and 

RCM2JB on the Prototyping Board. The header pins may become bent or damaged if 

the pin alignment is offset, and the module will not work. Permanent electrical damage 

to the module may also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets—press down in 

the area above the header pins using your thumbs or fingers over the connectors as shown 

in Figure 2. Do not press down on the middle of the RCM3209/RCM3229 module to avoid 

flexing the module, which could damage the module or the components on the module.

Should you need to remove the RCM3209/RCM3229 module, grasp it with your fingers 

along the sides by the connectors and gently work the module up to pull the pins away 

from the sockets where they are installed. Do not remove the module by grasping it at the 

top and bottom.
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2.2.2  Step 2 — Connect Programming Cable

The programming cable connects the RCM3209/RCM3229 to the PC running Dynamic C 

to download programs and to monitor the RCM3209/RCM3229 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on 

the RCM3209/RCM3229 module as shown in Figure 3. Be sure to orient the marked (usu-

ally red) edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, 

which is used for a normal serial connection.)

Figure 3.  Connect Programming Cable to RCM3209/RCM3229

Connect the other end of the programming cable to an available USB port on your PC or 

workstation. Your PC should recognize the new USB hardware, and the LEDs in the 

shrink-wrapped area of the USB programming cable will flash.

��"�!

�
!

��"�!

�
!

��� ��� ���

���

�
�
�

�
�
�

��"�!�����

�
�



�����
�������

��


 �

���

 ��

�������
�����������
������

�
�
"�
!

�


!

��"�!
��*	�


����


��

��

���

��


��*	�

�
�



�


�

�
�



 �

�"
���� ���

��
 �
�

�
�



�
�



���

�
�
�

�
�
�

 �


���

��

�
�

�
�

�
�

�
�

���

���

�



���

���

���

�%�

�%�

���

���

��


���

��


�
�

�
�

�
�

�



���

���

�
�

��


���

���

�%�

�%�

���

���

���

���

�	�

��


��


���


��
�

��


���

�	�

�	�

�	�

�%�

�%


���

��


���

���

!���

	)�

��	�

��

��

�����

����

���


����

���

���

�	�

�	�

�	


�	�

�%�

�%�

���

���

���


���

�
�
� �

���� �

��

�
�

��

��

��

$)��

 �

��������	�&	��	�����	���
$�	

���!	

������

����

�
�
�
�

$)��

�
�
�

��� $)�

�
�

�


��

��

��

����

���� �

���

�
!�
!

��"�!

�
!�
!

�����

�
�
�

�
�



�
�
�

���

���

�
�
�

�
�
�

$



�


��
��

��� ���

$�

��

 � $)�

���
���


��


����

����

����

����

$)��

���

$�

$�
���

$)�

���

$)


��� ���

�


!

�
�



�
�
�

�
�
�

�


�

�


�

�


�

�


�

�


!

�
�
	
�

�
�
�

�
�
�

�
�
�

�
�
�

�


�

�


�

�





�


�


�
�
�

 
�
�

���� �!������

�����������))��	��	�

����������������



�����������


 � ��


�����������


$�

 


��(���

�	�	�
���� �

�+����+�

�+����+���������������

��

��

�


���


����

����

$)�

����

����

����

$)�

 �

�
�

�
�

�
�

�
�

���

���

�



���

���

���

�%�

�%�

���

���

��


���

��


��

��"�!

!���

���

����


���

���

�	�

�	�

�	


�	�

�%�

�%�

���

���

���

��	�

��


��


���


��
�

��


���

�	�

�	�

�	�

�%�

�%


���

��


���

���

�
�

�
�

�
�

�



���

���

�
�

��


���

���

�%�

�%�

���

���

���

���

����$�

!���
	)�

��	�
��

���

����

����

����

����

����

����

�
�

�
�
�

�
�
�

�
�

�
�

�
�

�
�
�

�
�
�

����

����

�-../01

$�

 ��

���� �

$�

�
�

��

��


�
�

 �

$�

�
�

��

 �� �

�

 �� �� �� �
 �

�

���


�
�

�
�

�
�

�
�

���

$�

�
�

$�

�
�

�
�
�

���
�

��
��$


���

���

�
�
�

�
�



�
�
�

���

�
�
�

 
�
�

 
�
�
�

 
�
�

 
�
�

��

 �

�
�
�

�
�
�

�
�
�

���

��

�
�



�
�
�

�
�
�

�
�
�

�
�
�

�
�
�

���

���

�
�



$�

�
�
�

���

�
�
�

���

��

���������

���
���

���

���
���

���

�
�
�

���
$�

���

���

�
�
�

�
�
�

���

���
��
���

�

�
�
�

� $
�

�
�
�

�
�
�

�


�

 
�
�
�

 
�
�
�

���
���

 
�
�
�

�
�
�

��

�
�
�

�
�
�

 ��� ���

$�

��

���

���

�
�
�

��
���
��

���

�
�


��


��

�
	



�
�



�
�
�

�


�

�
�
�

�
�
�

�
�


��

�
�
�

�����))


�

$��

��

�
�
�

�
�
�

�
�
�

�2
�������320.

�
�
�
�

 
�



��
�

�
�
�
�

�2420/5�/56/

�
��
	�������	���



User’s Manual 11

2.2.3  Step 3 — Connect Power

When all other connections have been made, you can connect power to the Prototyping 

Board.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 

The RCM3209/RCM3229 Development Kit presently includes Canada/Japan/U.S., Aus-

tralia/N.Z., U.K., and European style plugs. Snap in the top of the plug assembly into the 

slot at the top of the AC adapter as shown in Figure 4, then press down on the spring-

loaded clip below the plug assembly to allow the plug assembly to click into place.

Connect the AC adapter to the power connector header J9 on the Prototyping Board as 

shown in Figure 4 below.

Figure 4.  Power Supply Connections

Plug in the AC adapter. The red power lamp on the Prototyping Board to the left of header 

J9 should light up. The RCM3209/RCM3229 and the Prototyping Board are now ready to 

be used.

NOTE: A RESET button is provided on the Prototyping Board to allow hardware reset 

without disconnecting power.
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2.3  Starting Dynamic C

Once the RCM3209/RCM3229 is connected as described in the preceding pages, start 

Dynamic C by double-clicking on the Dynamic C icon on your desktop or in your Start 

menu. Select Code and BIOS in Flash, Run in RAM on the “Compiler” tab in the 

Dynamic C Options > Project Options menu. Then click on the “Communications” tab 

and verify that Use USB to Serial Converter is selected to support the USB program-

ming cable. Click OK.

2.4  Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO 

window will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in 

Section 6.5, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the board.

2.4.1  Troubleshooting

If Dynamic C cannot find the target system (error message "No Rabbit Processor 

Detected."):

• Check that the RCM3209/RCM3229 is powered correctly — the power LED on the 

Prototyping Board should be lit when the RCM3209/RCM3229 is mounted on the Prototyping 

Board and the AC adapter is plugged in.

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and the PROG connector, not the DIAG connector, is plugged in to the program-

ming port on the RCM3209/RCM3229 with the marked (colored) edge of the program-

ming cable towards pin 1 of the programming header.

• Ensure that the RCM3209/RCM3229 module is firmly and correctly installed in its 

connectors on the Prototyping Board.

• Dynamic C uses the USB port specified during installation. Select a different COM 

port within Dynamic C. From the Options menu, select Project Options, then select 

Communications. Select another USB COM port from the list, then click OK. Press 

<Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C still reports it is 

unable to locate the target system, repeat the above steps until you locate the USB 

COM port used by the RCM3209/RCM3229 programming cable.

• If you get an error message when you plugged the programming cable into a USB port, 

you will have to install USB drivers. Drivers for Windows XP are available in the 

Dynamic C Drivers\Rabbit USB Programming Cable\WinXP_2K folder — 

double-click DPInst.exe to install the USB drivers. Drivers for other operating sys-

tems are available online at www.ftdichip.com/Drivers/VCP.htm.
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If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog on the “Communications” tab in the Dynamic C 

Options > Project Options menu. Select a slower Max download baud rate. Click OK 

to save.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Choose a lower debug baud rate. Click OK to save.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. The LEDs on the USB pro-

gramming cable will blink and you should receive a Bios compiled successfully 

message. 

2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to 

develop your own applications. The source code for the sample programs is provided to allow 

you to modify them for your own use. The RCM3209/RCM3229 User’s Manual also 

provides complete hardware reference information and describes the software function calls 

for the RCM3209 and the RCM3229, the Prototyping Board, and the optional LCD/keypad 

module.

For advanced development topics, refer to the Dynamic C User’s Manual and the 

Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.5.1  Technical Support

NOTE: If you purchased your RCM3209/RCM3229 through a distributor or through a 

Rabbit partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3209/RCM3229 (and

for all other Rabbit hardware), you must install and use Dynamic C.

3.1  Introduction

To help familiarize you with the RCM3209/RCM3229 modules, Dynamic C includes sev-

eral sample programs. Loading, executing and studying these programs will give you a 

solid hands-on overview of the RCM3209/RCM3229’s capabilities, as well as a quick 

start using Dynamic C as an application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C 

programming language. If you do not, see the introductory pages of the Dynamic C 

User’s Manual for a suggested reading list.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3209/RCM3229 module must be plugged in to the Prototyping Board as 

described in Chapter 2, “Hardware Setup.”

2. Dynamic C must be installed and running on your PC.

3. The RCM3209/RCM3229 module must be connected to your PC through the serial 

programming cable.

4. Power must be applied to the RCM3209/RCM3229 through the Prototyping Board.

Refer to Chapter 2, “Hardware Setup,” if you need further information on these steps.

Remember to allow the compiler to run the application in the program execution SRAM 

by selecting Code and BIOS in Flash, Run in RAM from the Dynamic C Options > 

Project Options > Compiler menu.

To run a sample program, open it with the File menu, then press function key F9 to com-

pile and run the program.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2  Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the 

RCM3209/RCM3229. Sample programs illustrating the general operation of the 

RCM3209/RCM3229, and serial communication are provided in the SAMPLES\RCM3200 

folder. Each sample program has comments that describe the purpose and function of the 

program. Follow the instructions at the beginning of the sample program.

• CONTROLLED.C—uses the STDIO window to demonstrate digital outputs by toggling 

LEDs DS1 and DS2 on the Prototyping Board on and off.

Parallel Port G bit 6 = LED DS1

Parallel Port G bit 7 = LED DS2

Once you have compiled and run this program, you will be prompted via the Dynamic C 

STDIO window to select LED DS1 or DS2. Use your PC keyboard to make your selec-

tion.

Once you have selected the LED, you will be prompted to select to turn the LED either 

ON or OFF. A logic low will light up the LED you selected.

• FLASHLED1.c—demonstrates the use of costatements to flash LEDs DS1 and DS2 on 

the Prototyping Board at different rates. Once you have compiled and run this program, 

LEDs DS1 and DS2 will flash on/off at different rates.

• FLASHLED2.c—demonstrates the use of cofunctions and costatements to flash LEDs 

DS1 and DS2 on the Prototyping Board at different rates. Once you have compiled and 

run this program, LEDs DS1 and DS2 will flash on/off at different rates.

• TOGGLESWITCH.c—demonstrates the use of costatements (cooperative multitasking) 

to detect switches using the press-and-release method of debouncing. LEDs DS1 and 

DS2 on the Prototyping Board are turned on and off when you press switches S2 and S3.

• IR_DEMO.c—Demonstrates sending Modbus ASCII packets between two Prototyping 

Board assemblies via the IrDA transceivers with the IrDA transceivers facing each other. 

Note that this sample program will only work with the RCM30/31/32XX Prototyping 

Board.

First, compile and run this program on one Prototyping Board assembly, then remove 

the programming cable and press the RESET button on the Prototyping Board so that 

the first RabbitCore module is operating in the Run mode. Then connect the program-

ming cable to the second Prototyping Board assembly with the RCM3209/RCM3229 

and compile and run the same sample program. With the programming cable still con-

nected to the second Prototyping Board assembly, press switch S2 on the second Proto-

typing Board to transmit a packet. Once the first Prototyping Board assembly receives a 

test packet, it will send back a response packet that will be displayed in the Dynamic C 

STDIO window. The test packets and response packets have different codes.

Once you have loaded and executed these five programs and have an understanding of 

how Dynamic C and the RCM3209/RCM3229 modules interact, you can move on and try 

the other sample programs, or begin building your own.
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3.2.1  Serial Communication

The following sample programs can be found in the SAMPLES\RCM3200\SERIAL folder.

• FLOWCONTROL.C—This program demonstrates hardware flow control by configuring 

Serial Port C (PC3/PC2) for CTS/RTS with serial data coming from TxB at 115,200 bps. 

One character at a time is received and is displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxB 

together on the RS-232 header at J5, and you will also tie TxC and 

RxC together using the jumpers supplied in the Development Kit as 

shown in the diagram.

A repeating triangular pattern should print out in the STDIO window. 

The program will periodically switch flow control on or off to demonstrate the effect of 

no flow control.

• PARITY.C—This program demonstrates the use of parity modes by 

repeatedly sending byte values 0–127 from Serial Port B to Serial Port 

C. The program will switch between generating parity or not on Serial 

Port B. Serial Port C will always be checking parity, so parity errors 

should occur during every other sequence.

To set up the Prototyping Board, you will need to tie TxB and RxC together on the 

RS-232 header at J5 using the jumpers supplied in the Development Kit as shown in the 

diagram.

The Dynamic C STDIO window will display the error sequence.

• SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial 

communication. Lower case characters are sent by TxC, and are 

received by RxB. The characters are converted to upper case and are 

sent out by TxB, are received by RxC, and are displayed in the 

Dynamic C STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxC together on the 

RS-232 header at J5, and you will also tie RxB and TxC together using the jumpers 

supplied in the Development Kit as shown in the diagram.

• SIMPLE5WIRE.C—This program demonstrates 5-wire RS-232 serial communication 

with flow control on Serial Port C and data flow on Serial Port B.

To set up the Prototyping Board, you will need to tie TxB and RxB 

together on the RS-232 header at J5, and you will also tie TxC and 

RxC together using the jumpers supplied in the Development Kit as 

shown in the diagram.

Once you have compiled and run this program, you can test flow con-

trol by disconnecting TxC from RxC while the program is running. Characters will no 

longer appear in the STDIO window, and will display again once TxC is connected 

back to RxC.
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• SWITCHCHAR.C—This program demonstrates transmitting and then receiving an 

ASCII string on Serial Ports B and C. It also displays the serial data received from both 

ports in the STDIO window.

To set up the Prototyping Board, you will need to tie TxB and RxC 

together on the RS-232 header at J5, and you will also tie RxB and 

TxC together using the jumpers supplied in the Development Kit as 

shown in the diagram.

Once you have compiled and run this program, press and release S2 

and S3 on the Prototyping Board. The data sent between the serial ports will be dis-

played in the STDIO window.

Two sample programs, 

SIMPLE485MASTER.C and 

SIMPLE485SLAVE.C, are available to 

illustrate RS-485 master/slave com-

munication. To run these sample pro-

grams, you will need a second Rabbit-

based system with RS-485, and you 

will also have to add an RS-485 trans-

ceiver such as the SP483E and bias 

resistors to the RCM30/31/32XX 

Prototyping Board.

The diagram shows the connections. You will have to connect PC0 and PC1 (Serial Port D) 

on the RCM30/31/32XX Prototyping Board to the RS-485 transceiver, and you will con-

nect PD4 to the RS-485 transceiver to enable or disable the RS-485 transmitter.

The RS-485 connections between the slave and master devices are as follows.

• RS485+ to RS485+

• RS485– to RS485–

• GND to GND

• SIMPLE485MASTER.C—This program demonstrates a simple RS-485 transmission of 

lower case letters to a slave RCM3209/RCM3229. The slave will send back converted 

upper case letters back to the master RCM3209/RCM3229 and display them in the 

STDIO window. Use SIMPLE485SLAVE.C to program the slave RCM3209/RCM3229.

• SIMPLE485SLAVE.C—This program demonstrates a simple RS-485 transmission of 

lower case letters to a master RCM3209/RCM3229. The slave will send back converted 

upper case letters back to the master RCM3209/RCM3229 and display them in the 

STDIO window. Use SIMPLE485MASTER.C to program the master RCM3209/

RCM3229.

3.2.2  Other Sample Programs

Section 6.5 describes the TCP/IP sample programs, and Appendix C.7 provides sample 

programs for the optional LCD/keypad module that can be installed on the Prototyping 

Board.
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4.  HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware

subsystems of the RCM3209/RCM3229. Appendix A, “RCM3209/

RCM3229 Specifications,” provides complete physical and electrical

specifications.

Figure 5 shows these Rabbit-based subsystems designed into the RCM3209/RCM3229.

Figure 5.  RCM3209/RCM3229 Subsystems
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